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Prepare Important Exam with TDA-C01 Exam Dumps(2024) 

Pass Exam Questions Efficiently With TDA-C01 Questions

Tableau TDA-C01 Exam Syllabus Topics:
TopicDetailsTopic 1- Get Started with Tableau: In this section of the exam, candidates are evaluated for the foundational skills to

begin their Tableau Desktop journey.Topic 2- Connect to and Transform Data: In this section, candidates are tested for their

skills in connecting to data sources, revising the properties of a data source, and saving those customizations. it also covers

how to modify connections and work with multiple data sources.Topic 3- Create Views and Dashboards: In this section of the

exam, candidates are tested for their knowledge of creating views, dashboards, and stories using basic and advanced chart

types. It includes structuring data by using groups, bins, and hierarchies.Topic 4- Publish and Manage Content: This section

covers the vital understanding of Tableau roles and licenses and the governance models and rules for publishing and

managing content. It also covers how to publish data and content on Tableau Server and Tableau Cloud.Topic 5- Explore and

Analyze Data: This section covers using calculations, LOD expressions, and table calculations to create new views and

insights.
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Tableau TDA-C01 Certification Exam is designed to test the knowledge and skills of candidates in various areas related to data

analysis and visualization. TDA-C01 exam consists of multiple-choice questions and is available in several languages. TDA-C01

exam has a duration of two hours and must be taken at a certified testing center or online through a remote proctoring service.

 

QUESTION 33

Open the link to Book1 found on the desktop. Open Disciplines worksheet.

Filter the table to show the Top 10 NOC based on the number of medals won.

 

 

*  Send us your feedback on it.

*  Send us your

QUESTION 34

You have a data source that contains data tor every city in the Unites States. The following is a sample of the data.
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You need to use the City dimension to create a dynamic filter that snows the cities that have a population greater than one million

Which type of filter should you use?

*  General filter

*  Top filter

*  Condition filter

*  Wildcard filter

To use the City dimension to create a dynamic filter that shows the cities that have a population greater than one million, you should

use a condition filter. A condition filter is a type of filter that shows only the values that meet a specified condition based on a

measure or a calculation. You can create a condition filter by dragging a dimension to the Filters shelf and selecting Condition from

the dialog box. Then you can enter a formula or choose an option that defines your condition.

In this case, you want to create a condition filter based on Population, which is a measure. You can drag City to the Filters shelf and

select Condition from the dialog box. Then you can choose By field from the tab and select Population > Sum > Greater than >

1000000 from the drop-down lists. This will create a condition filter that shows only the cities that have a sum of population greater

than one million.

The other options are not correct for this scenario. A general filter is not a specific type of filter, but a term that refers to any type of

filter in Tableau. A wildcard filter is a type of filter that shows only the values that match a specified pattern or string, such as

&#8220;New*&#8221; or &#8220;*ton&#8221;. A top filter is a type of filter that shows only the top or bottom N values of a

measure or dimension based on a ranking or an aggregation. Reference:

https://help.tableau.com/current/pro/desktop/en-us/filtering.htm

https://help.tableau.com/current/pro/desktop/en-us/filtering_condition.htm

https://help.tableau.com/current/pro/desktop/en-us/filtering_wildcard.htm

https://help.tableau.com/current/pro/desktop/en-us/filtering_topn.htm

QUESTION 35

You have the following dashboard.
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Currently the map is used as a filter that affects the data on the otter sheets of the dashboard You need to configure the dashboard to

ensure that selecting a data point on the map only tillers the Detail table What should you do?

*  From the context menu of Sales over time select Ignore Actions

*  From the context menu of Sales over lime select Remove Dashboard Item

*  From the context menu of Profits by Stale deselect Use as Filter

*  From the context menu of Sales over time select Deselect

QUESTION 36

You want to connect a Tableau workbook to a dataset in a Microsoft Excel spreadsheet.

What should you do from Tableau Desktop?

*  From the Data menu select New Data Source

*  From the Data menu select Replace Data Source

*  From the File menu select New

*  From the File menu select Import Workbook

QUESTION 37

You have the following dataset.

 

 

Which Level of Detail (LOD) expression should you use to calculate tie grand total of all the regions?

*  {FIXED: [Region] SUM Sales}

*  {FIXED: SUM Sales}

*  {Fixed: [Region]: TOTAL Sales}

*  {FIXED: TOTAL (Sales)}

QUESTION 38

Open the link to Book1 found on the desktop. Open the Histogram worksheet and use the Superstone data source.

Create a histogram on the Quantity field by using bin size of 3.
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*  check the steps below in explanation

To create a histogram on the Quantity field by using bin size of 3, you need to do the following steps:

Open the link to Book1 found on the desktop. This will open the Tableau workbook that uses the Superstore data source.

Click on the Histogram tab at the bottom of the workbook to open the Histogram worksheet. You will see a blank worksheet with no

marks.

Right-click on Quantity in the Measures pane and select Create Bins from the menu. This will open a dialog box that allows you to

create bins for the Quantity field. Bins are groups of values that are treated as one unit in a histogram.

Enter 3 in the Size of bins text box. This will set the bin size to 3, which means that each bin will contain values that are 3 units

apart. For example, one bin will contain values from 0 to 2, another bin will contain values from 3 to 5, and so on.

Click OK to create the bins. You will see a new field named Quantity (bin) in the Measures pane with a # sign next to it.

Drag Quantity (bin) from the Measures pane to Columns on the worksheet. This will create a histogram that shows the distribution

of Quantity by bins. You will see bars that represent the frequency or count of values in each bin.

Optionally, you can adjust the width, color, and labels of the bars by using the options on the Marks card. You can also add filters,

tooltips, or annotations to enhance your histogram.

QUESTION 39

You have the following tiled dashboard that has one sheet.
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You want to replace the sheet with Sheet2.

What should you do?

*  Right-click Sheet2 and select Add to Dashboard.

*  Select Sheet3 and click the Swap Sheet button next to Sheet2.

*  From the context menu of Sheet3. select Remove Dashboard item

*  Drag Sheet2 to the dashboard.

*  From the context menu of Sheet3. select Deselect

In Tableau, to replace a sheet on a dashboard, you can simply drag the desired sheet (Sheet2 in this case) from the sheets list onto the

dashboard area where the current sheet (Sheet3) resides. This action will replace the existing sheet with the new one. Right-clicking

and adding to the dashboard adds an additional sheet rather than replacing, and the context menu options mentioned in the other

choices are not the standard methods for replacing sheets within a dashboard.

QUESTION 40

Open the link to Book1 found on the desktop. Open SalesVSProfit worksheet.

Add a distribution band on Profit to show the standard deviation from- 1 to 1.
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check the steps below in explanation.

Explanation:

To add a distribution band on Profit to show the standard deviation from -1 to 1, you need to do the following steps:

Open the link to Book1 found on the desktop. This will open the Tableau workbook that contains the SalesVSProfit worksheet.

Click on the SalesVSProfit tab at the bottom of the workbook to open the worksheet. You will see a scatter plot that shows the

relationship between Sales and Profit for each Sub-Category.

Click on the Analytics tab on the left side of the workbook to open the Analytics pane. You will see a list of analytical objects that

you can drag and drop onto your worksheet.

Drag Distribution Band from the Analytics pane to Profit on the Rows shelf. This will add a distribution band on Profit that shows

the average and confidence interval for each Sub-Category.

Click on the Edit button on the distribution band to open the Edit Distribution Band dialog box. You will see options to customize

your distribution band.

Change the Band From value to -1 and the Band To value to 1. This will change the distribution band to show the standard deviation

from -1 to 1, which means one standard deviation below and above the average.

Click OK to apply the changes. You will see that the distribution band now shows a narrower range of values for Profit.

References: https://help.tableau.com/current/pro/desktop/en-us/analytics.htm

https://help.tableau.com/current/pro/desktop/en-us/analytics_distributionband.htm

https://help.tableau.com/current/pro/desktop/en-us/analytics_distributionband_edit.htm

QUESTION 41

You have the following box plot that shows the distribution of average profits made in every state by region.
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Which region has the smallest distribution of profits?

*  South

*  Cast

*  Central

*  West

The central region has the smallest distribution of profits because it has the smallest interquartile range (IQR), which is the distance

between the first and third quartiles of the box plot. The IQR measures the spread of the middle 50% of the data. The smaller the

IQR, the less variation in the data. Reference: https://help.tableau.com/current/pro/desktop/en-us/buildexamples_boxplot.htm

https://www.statisticshowto.com/probability-and-statistics/interquartile-range/

QUESTION 42

You want to add a draft watermark to a dashboard as shown in the following exhibit.
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Which type of object should you use?

*  Image

*  Sheet

*  Web page

*  Horizontal

QUESTION 43

You have a data set that contains three columns named Sales, Profit, and Quantity.

You need to build the following scatter plot.
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QUESTION 44

Open the link to Book1 found on the desktop. Open Disciplines worksheet.

Filter the table to show the members of the Top10 set and the members of the Bottom10 set. There should be a total of 20 rows.
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*  Send us your feedback on it.

*  Send us your

QUESTION 45

You have the following visualization.
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QUESTION 46

You have a Tableau workbook that contain three worksheets named Sheet1 Sheet2 and Sheet3.

You create several filters.

From the Data Source page you plan to add data source fillers

When type of filter will appear in the Edit Data Source Filters dialog box?

*  A table calculation filter used on Sheet

*  A top N condition filer on a dimension in Sheet 1 and Sheet2

*  A context filler on a dimension m Sheet3

*  A dimension filter on all the sheets

A data source filter is a filter that applies to all the worksheets that use the same data source. It filters the data before any other filters

or calculations are applied. You can add a data source filter from the Data Source page by clicking on the Add button next to Filters.

The type of filter that will appear in the Edit Data Source Filters dialog box is a dimension filter on all the sheets. This means that

you can choose a dimension from your data source and filter it by values, range, condition, or top/bottom. The filter will affect all

the worksheets that use that dimension.

The other types of filters are not data source filters and will not appear in the Edit Data Source Filters dialog box. A table calculation

filter is a filter that applies to a table calculation, such as percent of total or running total. A top N condition filter is a filter that

shows only the top or bottom N values of a measure or dimension based on a condition. A context filter is a filter that creates a

subset of data that other filters can use.

QUESTION 47

Open the link to Book1 found on the desktop. Open Disciplines worksheet.

Filter the table to show the members of the Top10 set and the members of the Bottom10 set. There should be a total of 20 rows.
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check the steps below in explanation.

Explanation:

To filter the table to show the members of the Top10 set and the Bottom10 set, you need to do the following steps:

Open the link to Book1 found on the desktop. This will open the Tableau workbook that contains the Disciplines worksheet.

Click on the Disciplines tab at the bottom of the workbook to open the worksheet. You will see a table that shows the disciplines,

sales, and profit for each salesperson.

Click on the drop-down arrow next to Salesperson on the Filters shelf. This will open a menu that allows you to filter by different

criteria.

Select Set from the menu. This will show you the sets that are available for the Salesperson field. You will see Top10 and Bottom10

as two sets that have been created based on the sales ranking.

Check the boxes next to Top10 and Bottom10. This will filter the table to show only the members of these two sets. You can also

click on All to deselect all other values.

Click OK to apply the filter. You will see that the table now shows 20 rows, 10 for each set.

References: https://help.tableau.com/current/pro/desktop/en-us/sets.htm

https://help.tableau.com/current/pro/desktop/en-us/filtering.htm

Prepare Important Exam with TDA-C01 Exam Dumps(2024) [Q33-Q56] |  Page 13/22  |

https://certify.vceprep.com/2024/09/12/prepare-important-exam-with-tda-c01-exam-dumps2024-q33-q56/
https://certify.vceprep.com/2024/09/12/prepare-important-exam-with-tda-c01-exam-dumps2024-q33-q56/


This page was exported from - Latest Exam Prep 
Export date: Mon Sep 23 12:17:35 2024 / +0000  GMT

QUESTION 48

In a dataset, you have a string field named Name that contains unnecessary semicolons.

Which function should you use to remove the semicolons from the Name field?

*  TRIM

*  CONTAINS

*  REPLACE

*  SPLIT

The REPLACE function is used to replace all occurrences of a substring within a string with another substring. In this case, it can be

used to remove the semicolons from the Name field by replacing them with an empty string. For example, REPLACE

(&#8220;John;Doe&#8221;, &#8220;;&#8221;, &#8220;&#8221;) = &#8220;JohnDoe&#8221;. Reference: The information is

based on the following sources:

String Functions &#8211; Tableau

Remove special characters and add a semi colon in a word &#8211; Tableau

QUESTION 49

You have a table that contains four columns named Order Date, Country, Sales, and Profit.

You need to add a column that shows the day of the week for each row. For example, orders placed on August 31, 2022, will show a

day of Wednesday.

How should you complete the formula? (Use the dropdowns in the Answer Area to select the correct options to complete the

formula.)
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Reference:

Tableau Help: DATENAME Function

Tableau Help: Date Functions

To add a column that shows the day of the week for each row, you should complete the formula as follows:

DATENAME

(

&#8216;weekday&#8217;

, [Order Date])

The DATENAME function in Tableau returns the name of a specified part of a date or datetime value, such as the year, month, or

day. It takes two arguments: the date part and the date. In this question, you want to return the name of the weekday, such as

Monday, Tuesday, or Wednesday, for each order date. Therefore, you need to use &#8216;weekday&#8217; as the date part and

[Order Date] as the date. The formula will return a string value that represents the name of the weekday for each order date.

Tableau Help: DATENAME Function

Tableau Help: Date Functions

QUESTION 50

You have two data sources that use the same schema One data source contains order data from 2019 and the other data source

contains order data from 2020.

You have a worksheet that shows the orders from 2019.

You need to configure the worksheet to show the orders from 2020 without reloading the data.

Which option should you select?
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QUESTION 51
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You have the following dataset.

 

 

Which formula calculates the percent difference in sales relative to the same quarter the previous year as shown in the Calculation

field?

*  (SUM ([Sales]) &#8211; LOOKUP (SUM ( [Sales]), -4))

*  (SUM ([Sales]) &#8211; LOOKUP (SUM ([Sales]), -4) ) / (LOOKUP (SUM ([Sales]), -4) )

*  (SUM([Sales]) / (LOOKUP (SUM ([Sales]), -4))

*  (ZN (SUM ([Sales]) ) &#8211; LOOKUP (ZN (SUM ([Sales]) ), -4) )

The formula in option B calculates the percent difference in sales relative to the same quarter the previous year. It subtracts the sales

of the same quarter from the previous year from the current year&#8217;s sales, and then divides this by the previous year&#8217;s

sales. This gives a percentage change, which aligns with what is shown in the Calculation field of your dataset. The LOOKUP

function returns the value of a specified offset from the current row in the partition. In this case, the offset is -4, which means the

value of the same measure four rows above the current row. This corresponds to the same quarter of the previous year, assuming the

data is sorted by quarter. References:

LOOKUP Function &#8211; Tableau

Table Calculations &#8211; Tableau

Tableau Certified Data Analyst Study Guide

QUESTION 52

You have a dashboard than contains two sheets named Sheet 1 and Sheet 2.

You want to add an object to the dashboard that users can click to switch to a different dashboard in the workbook.

Which object should you add to the dashboard?
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Explanation:

The object that you should add to the dashboard to allow users to switch to a different dashboard in the workbook is Navigation.

Navigation objects are used to create links between dashboards or sheets in a workbook. You can add a navigation object to a

dashboard by dragging it from the list of objects and dropping it on the dashboard. You can then configure the navigation object to

specify the destination dashboard or sheet that you want users to navigate to when they click on it.

You can learn more about navigation objects and how to use them in this article:

https://help.tableau.com/current/pro/desktop/en-us/dashboards_navigation.htm

QUESTION 53

Open the link to Book1 found on the desktop. Use the Superstore data source.

Split the Customer Name field into two fields named First Name and Last Name.
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check the steps below in explanation.

Explanation:

To split the Customer Name field into two fields named First Name and Last Name, you need to do the following steps:

Open the link to Book1 found on the desktop. This will open the Tableau workbook that uses the Superstore data source.

Go to the Data Source tab at the bottom of the workbook to see the data source page. You will see a table that shows the fields and

values from the Superstore data source.

Right-click on Customer Name in the table and select Split from the menu. This will split the field into two fields based on a

separator, which is a space by default. You will see two new fields named Customer Name &#8211; Split 1 and Customer Name

&#8211; Split 2 in the table.

Right-click on Customer Name &#8211; Split 1 and select Rename from the menu. Type First Name as the new name and press

Enter. This will rename the field as First Name.

Right-click on Customer Name &#8211; Split 2 and select Rename from the menu. Type Last Name as the new name and press

Enter. This will rename the field as Last Name.

References: https://help.tableau.com/current/pro/desktop/en-us/datasource_prepare.htm

https://help.tableau.com/current/pro/desktop/en-us/split.htm

https://help.tableau.com/current/pro/desktop/en-us/renamefield.htm
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QUESTION 54

You have a dataset that contains sates dat

a. The following is a sample of the data.

 

 

You need to return a value of true if a month has sales greater than $50 000. otherwise the formula must return a value of false.

Which two formulas achieve the goal Choose two

*  SUM{[Sales]) IN (50000)

*  IIF(SUM< [Sales] )>50000, TRUE, FALSE)

*  MAX< [Sales], 50000)

*  [Sales] > 50000

B) IIF(SUM([Sales]) > 50000, TRUE, FALSE) D. [Sales] > 50000

The IIF function is a logical function that returns one value if a condition is true, and another value if the condition is false. In this

case, the condition is SUM([Sales]) > 50000, which means that the sum of sales for a month is greater than $50,000. The function

will return TRUE if the condition is true, and FALSE if the condition is false.

The comparison operator > is a logical operator that returns TRUE if the left operand is greater than the right operand, and FALSE

otherwise. In this case, the operands are [Sales] and 50000, which means that the sales for a month are greater than $50,000. The

operator will return TRUE if the sales are greater than $50,000, and FALSE otherwise.

The other options are not correct for this scenario. The IN function is a logical function that returns TRUE if a value is in a set of

values, and FALSE otherwise. In this case, the value is SUM([Sales]), which is not in the set of values (50000). The function will

always return FALSE. The MAX function is an aggregation function that returns the maximum value in a field or expression. In this

case, the field or expression is [Sales], 50000, which is not valid syntax. The function will return an error. Reference:

https://help.tableau.com/current/pro/desktop/en-us/functions_functions_logical.htm#IIF

https://help.tableau.com/current/pro/desktop/en-us/operators.htm

https://help.tableau.com/current/pro/desktop/en-us/functions_functions_aggregate.htm#MAX Explanation:

The two formulas that will return a value of true if a month has sales greater than $50,000, otherwise the formula must return a value

of false, are:

QUESTION 55

You have the following visualization.

Prepare Important Exam with TDA-C01 Exam Dumps(2024) [Q33-Q56] |  Page 20/22  |

https://certify.vceprep.com/2024/09/12/prepare-important-exam-with-tda-c01-exam-dumps2024-q33-q56/
https://certify.vceprep.com/2024/09/12/prepare-important-exam-with-tda-c01-exam-dumps2024-q33-q56/


This page was exported from - Latest Exam Prep 
Export date: Mon Sep 23 12:17:38 2024 / +0000  GMT

 

 

You Create a table calculation named Rank_Score that has a formula of RANK(AVG([Score]), and you drag Rank_Score to Text on

the Marks cards.

What is the Rank Score value for Student ID 4220?

*  5

*  4

*  6

*  3

To determine the Rank Score value for Student ID 4220, we look at the visualization provided and apply the table calculation of

RANK(AVG([Score])). This function will rank the average scores in ascending order by default, with the lowest score receiving the

rank of 1.

Based on the provided visualization, the scores for the students are as follows (from lowest to highest average score):

Student ID 4183: 39 (Rank 1)

Student ID 4220: 71 (Rank 6)

Student ID 4247: 71 (Rank 6, same score as ID 4220 so they share the same rank) Student ID 4124: 75.5 Student ID 4050: 64

Student ID 4205: 67 Student ID 4056: 66 Since Student ID 4220 has an average score of 71, which is the third-highest score, it

shares the rank with Student ID 4247. However, since Tableau ranks without gaps, the actual rank assigned is 6, considering that

there are two students with a rank of 4 (due to the same average score being the second lowest), making the next rank number 6.

Note: The actual ranks for the highest scores are not provided, but they are not needed to determine the rank for Student ID 4220.

https://help.tableau.com/current/prep/en-us/prep_calculations.htm

QUESTION 56

You have the following dataset.
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Yon need to calculate the ranking shown in the Rank field.

How should you complete the formula? (Use the dropdowns in the Answer Area to select the correct options to complete the

formula ?
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